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PROJECT OVERVIEW
INSTRUCTIONAL NEED

The third-largest workforce (Newhouse & Salamon, 2020, p. 4) and generator of income and tax revenue (Newhouse & 
Salamon, 2020, p.7), the nonprofit sector continues to grow and evolve at a significant rate. According to Newhouse and 
Salamon at the Johns Hopkins Center for Civil Society Studies (2020), the nonprofit workforce increased by 18.6 percent 
between 2007 and 2017 (p. 9). Although the impact of COVID-19 led to a 13.2 percent decrease from pre-pandemic levels 
between March-May 2020 (2022), as of March 2022, the Center now projects that the overall sector will return to pre-
pandemic levels within the next eight months (2022). As the visions of these nonprofit agencies evolve, so do the duties and 
expectations of their development and communications staff. 
 
Nonprofit-related job listings with titles including “communications coordinator” and “development associate” often list graphic 
design under necessary job duties and preferred experience. At many agencies, nonprofit development and communications 
staff need to be able to design and maintain websites that cater to donors, clients, and new and existing staff. Staff also need 
to create graphics for social media and e-mail marketing campaigns. Finally, staff must be able to design event invitations 
and annual fundraising mail campaigns according to printer guidelines.
 
Yet, if staff members do not possess any education and background in graphic design, the quality and professionalism of the 
agency’s brand image often suffer. I found glaring errors when reviewing the websites and print materials of five healthcare-
related nonprofits in Southern California. Website text was difficult to read or comprehend due to the font, colors, and 
spacing. Furthermore, some print materials included unintended white margins around the edges of the page, illustrating 
that staff members did not know how to apply bleeds. Many product research, marketing, and design-related blogs like 
Sageworld (2019), Axies (2021), and Visme (2015) list a lack of knowledge of design principles like hierarchy, balance, 
and color; improper file formatting; and inaccessible design as common novice errors. These reports echo my results 
from surveying three former and current graphic designers in the nonprofit sector. Interviewees listed web accessibility 
guidelines, principles of designs, and practical technical knowledge among top knowledge and skills they wish they had 
better possessed as entry-level employees. 
 
In Usability: Principles and Practices for Designing Digital Applications, Schatter and Levinson (2013) attribute these 
knowledge gaps to the overlap of roles and diversity of disciples (xii) from which professional graphic designers come. 
Given so many novice errors are rooted in both aesthetically pleasing and functional design, Schatter and Levinson (2013) 
call for better and more training in “visual usability” or “design grounded in principles and an understanding of people” (xii). 
At the intersection of user-centered design and usability also lies accessibility. The World Wide Web Consortium (W3C)’s 
Web Accessibility Initiative (WAI) (2022) states that accessible design “improves overall user experience and satisfaction, 
especially in a variety of situations, across different devices, and for older users.” The stakes for not adhering to web 
accessibility and visual usability guidelines are high, and there can be grave legal consequences as well. 
 
Instead of hiring outside consultants or firing and rehiring new staff, nonprofit agencies can save significant time, costs, 
and resources by providing current staff members with the necessary training to help them excel at graphic design-related 
duties. This project aims to develop the training for development and communications staff to acquire the knowledge, skills, 
and experience necessary to abide by accepted industry design and accessibility standards. This project will also develop 
training to help staff members carry out tasks related to designing for the web and print production. Overall, this training 
ensures associates can fulfill their day-to-day duties effectively, helps nonprofit agencies enhance their visual brand images, 
and reduces the costs of hiring outside consultants for troubleshooting and additional support.

DELIVERY METHOD

This course will be delivered through computer-based training (CBT) eLearning modules on accessibility, file types, and 
design to reach as many learners as possible. This training will also be SCORM-compliant and flexible enough for agencies 
to upload it to their unique SCORM-compliant LMSs. Given their diverse array of responsibilities, learners can take this 
course at their own time and own pace. Learners will also receive aids during the training to help them learn, practice, and 
retain their new knowledge, skills, and experience. 
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TARGET LEARNER PROFILE
PRIMARY AUDIENCE
Nonprofit development staff

SECONDARY AUDIENCE
Development staff managers
Freelancers
Instructional designers
Entry-level graphic designers

GENERAL LEARNER 
CHARACTERISTICS
Experience: Entry- and mid-level 
Education: Bachelor’s degree
Design-Related KSAs: Beginner 
to intermediate experience with little 
to no formal design education

PREREQUISITE SKILLS
Project Management
Mac/PC Platforms 
Email Marketing
Social Media
Website Management
Canva
Adobe Creative Suite

ATTITUDINAL CHARACTERISTICS
Learners are motivated by:
• salary and job security
• public-facing work
• meaningful agency impacts
• professional growth
• future opportunites

TOP 3 COMMON ERRORS
Low accessibility
    • No knowledge of WAI’s 	  
    perceivable guidelines 
   (e.g., low color contrast)
Design knowledge gaps
    • Issues with alignment,  
    hierarchy, balance, and scale
Incorrect file formatting
    • Color profiles   
    • Image resolution
    • Margins and bleeds
    • Web and print file types

OVERVIEW

In today’s world, the KSAs of nonprofit development staff encompass many different 
professional fields. In addition to event planning and fundraising, staff members often 
design agency websites, social media assets, e-mail marketing campaigns, print 
advertisements, and event invitations. To be successful, staff members must have 
a comprehensive understanding of graphic design. Yet, without formal education 
or prior experience, staff members struggle to apply design principles, differentiate 
between web and print file specifications, and design accessibly for a diverse range 
of audiences. With their time and services already being pulled in multiple directions, 
they also struggle to effectively apply outside feedback when revising their designs. 

CONTEXTUAL ANALYSIS

	 ORIENTING CONTEXT
Learner Goals: Learners want to successfully complete their graphic design-
related job tasks without error and become adept graphic designers. 
Training Purpose: This instruction equips learners with the knowledge and skills 
necessary to abide by industry design standards and W3C’s Web Acessibility 
Initiative’s (WAI)’s Web Content Accessibility Guidelines (WCAG). This instruction 
will also train learners how to format their files correctly according to web and print 
specifications.
Accountability: Attitudinal characteristics relating to professional growth along with 
the direct consequences of their public-facing work hold learners accountable. 
Potential Misconceptions: New technology, terminology, and tasks that require 
memorization and dexterity may rouse insecurity and confusion. Time constraints 
alongside a steep learning curve may cause learners to feel unmotivated and 
less invested. Because these factors could decrease the chances of on-the-job 
knowledge transference, training will employ practice activities, job aids, and self-
reflection questions to help increase learner confidence and post-training success.

	 INSTRUCTIONAL CONTEXT
Because learners wear so many different hats at their jobs and take on a range 
of tasks each day, this training will be delivered through self-paced eLearning 
modules to offer learners agency in managing their time and learning progress.

	 TRANSFER CONTEXT
Learners will directly apply design knowledge to their daily tasks, which include the 
creation of social media posts, event flyers, website banners, and e-newsletters. 
Learners will be given job aids following the instruction for additional support. 

	 TECHNOLOGY INVENTORY
Learners have access to cell phones and desktop computers along with printers.  
Learners subscribe to Adobe Creative Suite along with Canva. They also have 
company social media and website logins.

TARGETED SPONSORING ORGANIZATIONS

This training targets nonprofit agencies along with freelancers, instructional design-
ers, and other small business employees handling a myriad of tasks. The missions 
of these kinds of organizations often support local communities. To meet their annual 
budgets, these agencies rely on donations through seasonal web and print fundrais-
ing campaigns along with annual fundraising events. Nonprofit development staff 
members usually report to CEOs, development directors, and boards of directors, 
which help advance agencies’ missions by managing their future and day-to-day 
decisions.
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INSTRUCTIONAL STRATEGIES & LEARNING THEORIES 

INSTRUCTIONAL STRATEGIES

	 MAGER’S GUIDELINES FOR WRITING OBJECTIVES
Mager’s Preparing Instructional Objectives provides a template for developing more tangible course objectives. Mager (1997) 
formats objectives by including three specifications—the desired performance, the conditions under which the action should 
be performed, and the criteria for acceptable performance (p. vii). Recent research completed by contemporary researcher 
Thalheimer (2015) also illustrates the importance of writing objectives for multiple audiences. Although Mager’s template 
may help trainers develop instruction, Thalheimer (2015) recommends rewriting objectives in a more conversational tone that 
motivates learners, ensuring objectives remain “salient” throughout the training. Including pre-questions, distilling complex 
topics, and abiding by best practices in visual design can also help retain learners’ attention.

Both Bloom’s original taxonomy and the 2001 collaborative revision, A Taxonomy for Teaching, Learning, and Assessment, 
helped me categorize my learning objectives across a spectrum of factual, conceptual, procedural, and metacognitive 
knowledge types (Anderson et al., 2001, pp. 27-29). With this framework, I can develop useful activities that will help learners 
ultimately meet these objectives.

	 ALIGNMENT
A core tenet of instructional design, alignment might best be described as the harmony between instructional strategies, 
assessment strategies, and terminal objectives. Properly aligning instruction with its learning outcomes keeps learning 
focused on the instructional need, ensuring learners can fulfill the overall instructional need post-training. It also immediately 
sets learner expectations, builds trust between learners and their training facilitator, and motivates learners by continually 
reminding them of the practical applications and benefits of their new learning. Furthermore, it makes it easier for trainers to 
measure and evaluate assessment.

To ensure proper alignment, I will use “backward design,” a framework introduced by Grant Wiggins and Jay McTighe in their 
1998 book Understanding by Design. Backward design uses the learning objectives as the foundation upon which to design 
the rest of the learning curriculum. To ensure each instructional component closely connects, instructional designers work 
backward from objectives to assessment strategies to activities, and so on… To explain the rationale behind this methodology, 
Wiggins and McTighe (1998) state,

Our lessons, units, and courses should be logically inferred from the results sought, not derived from the methods, books, 
and activities with which we are most comfortable. The curriculum should lay out the most effective ways of achieving specific 
results… In short, the best designs derive backward from the learnings sought” (p.14).

By using backward design to align learning outcomes with each facet of the instruction itself, I aim to maximize results and 
improve learners’ confidence as they move forward through each module.

My instruction typically structures activities through Horton’s “absorb-do-connect” methods, as outlined in his 2006 book, 
E-Learning by Design. In “absorb” activities, learners “absorb” new information (Horton, 2006, p.51). On the whole, these 
activities may sound passive, but they actually require learners to remain “mentally active” (Horton, 2006, p.51). “Do” activities 
involve hands-on practice and exploration while “connect” activities stir real-world application and integrate new learning 
material with learners’ prerequisite skills and knowledge (Horton, 2006, p.51). Many of the activities in these categories 
overlap with each other. For example, assessment can be an integral part of “do” activities to help learners see the fruits 
of their practice. Incorporating “connect” activities into “absorb” activities can help learners better comprehend introductory 
knowledge and connect it to prior experience. “Connect” activities following assessment can also help learners gauge their 
current KSAs and reflect on their in-progress learning. Sequenced together, these activities help transition new KSAs from 
working load into long-term memory, scaffold learning, and align instruction, providing learners with a clear path to success.
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	 AUTHENTIC ASSESSMENT
I will employ a variety of assessment strategies to assess and evaluate both learners’ development and the effectiveness 
of my instruction. In Measuring Instructional Results, Mager (1984) defines assessment as a “sound base” for measuring 
whether learners have mastered a learning objective or not (p. 9). Mager (1984) defines evaluation as not only the comparison 
between “a measurement with a standard” but also the “judgment on the comparison” (p. 8). Considering both assessment 
and evaluation can ensure my instruction need is truly met and help me improve the design of future iterations of this training. 
Kirkpatrick’s four-level evaluation model offers ideas for how to evaluate everything from learners’ motivation during the 
training to the training’s long-term impacts on agencies.

Assessment will occur at almost every step of my training. Integrating assessment into practice activities will help learners 
integrate new knowledge and allow trainers to monitor their progress. I will include formative feedback and open-ended 
analytical rubrics in performance-based, authentic assessment. Sandwiching constructive feedback with positive feedback 
helps learners instill self-confidence and focus on specific strengths and weaknesses. In addition, scored open-ended 
analytical rubrics help learners create tangible action plans for their learning. Introducing rubrics and job aids early on also 
provides a cogent description of the learner’s KSAs and a method of criterion-referenced evaluation, which measures learners’ 
development against an “objective standard” (Mager, 1984, p. 10). Progress is marked through a student’s improvement 
throughout the course, which necessitates a before-and-after holistic understanding of a student’s skills and abilities. 
Embedding both a revision strategy and post-training reflection into assessment is what Mager (1984) calls a “diagnostic” (p. 
12) tool that could help trainers determine why a criterion has not been met.

Following Horton’s best practices, my questions will be written in active, unambiguous language and include a short narrative 
lead-in (p. 247). Feedback will build on learners’ in-progress learning, and incorrect answers will offer hints to steer them 
toward the correct answer. 

UNIVERSAL DESIGN & INCLUSIVE LEARNING

As an undergraduate instructor committed to equity, diversity, and inclusion in my classroom, I am already familiar with many 
of UDL (Universal Design for Learning) recommendations.

To promote multiple means of engagement, I will give learners many opportunities to receive outside feedback. Learners 
will also have creative control and autonomy when creating digital designs during case studies and performance simulations. 
Activities and assessments are loosely self-timed to allow learners to negotiate their other job tasks and responsibilities. 
Learners will also have multiple opportunities to reflect on their development and create their own learning goals. Reflection 
questions and terminal objectives reminders will aid these self-assessment activities. Realistic on-the-job-scenario-based 
practice activities and assessment strategies will illustrate the learning’s relevancy to their jobs and goals. Good alignment 
along with strong graphic design and inclusive messaging “minimizes threats and distractions” (CAST) while holistic 
formative feedback and rubrics lead to positive yet constructive “master-oriented feedback” (CAST).

Given my course teaches graphic design, I cannot make this training accessible for completely vision-impaired audiences. 
However, this instruction does help designers design more accessibly, focusing on color-blind audiences specifically, and 
will follow perceivable web accessibility guidelines as well. To offer multiple means of representation, I plan to include 
visual representations of design principles and other key concepts to illustrate the application of these principles. I will 
ensure the design of my course properly uses design principles like proximity, alignment, and unity so learners can deduce 
logical relationships and hierarchies of information. Many of my activities are also performance-based, giving learners 
hands-on practice. I will provide captions and transcripts alongside any audio too.

To allow for multiple means of expression and action, I will offer a variety of assessment strategies and activities. Job 
aids, worked examples, rubrics, resources, and glossaries will also help scaffold learning. Each activity involves multiple 
steps and opportunities for feedback. Learners must also show the rationale behind their design processes and create plans 
for revision before finalizing their work.

INSTRUCTIONAL STRATEGIES & LEARNING THEORIES 
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LEARNING THEORIES

	 CONSTRUCTIVISM, BEHAVIORISM, MOTIVATION, & ADULT LEARNING THEORY
Constructivism posits that we actively construct knowledge from our experiences and surroundings while behaviorism 
posits that our environments have an immense impact on our behaviors. I will use these theories to better involve learners 
and motivate them to take charge of their learning. To encourage motivation, I will use assumptions from Knowles’ adult 
learning theory or andragogy and the expectancy-value model as outlined in Vanderbilt University’s Center for Teaching 
“Motivating Students” guide to inform the development of my training. Although the training needs to be aligned with the 
overall instructional goal, it must also be relevant to learners’ goals and designed flexibly enough to meet their varied learning 
styles. I aim to help students recognize and value their capabilities by offering an adequate array of models, digital tools, and 
resources to help them succeed. I will also clarify the measurable benefits these new skills will provide. Clear expectations 
and objectives along with positive formative feedback and engaging, student-centered learning material will also aid them as 
they progress through the training.  

	 MODULES, CHUNKING, AND COGNITIVE LOAD
To estimate what learners can ealistically complete and learn during the training, I will refer to the theories of cognitive load 
and chunking. Sweller once defined long-term memory as the “sophisticated structures that permit us to perceive, think, 
and solve problems” (quoted in Solomon, 2018). To maximize learning, consider schema, which forms memory’s structure. 
A novice learner does not have the same schematic structures as an expert, but practice makes perfect; the more familiar 
learning material becomes, the more integrated it becomes in long-term memory. By including guided analyses and case 
studies in my training, I hope to provide worked examples that provide step-by-step solutions along with goal-free problems 
that replace specific goals with more general ones. I’ve also divided my training by modules, lessons, and topics to chunk 
my content as Miller recommended in his 1956 seminal paper “The magic number 7 plus and minus 2.” Chunks along with 
memory devices such as mnemonics and paraphrasing (Clark, 2012) help learners reduce memory overload and smooth the 
transition of knowledge from working memory into long-term memory.

	 MAYER’S MULTIMEDIA PRINCIPLES 
Given my background in graphic design and the fact the training revolves around visual design, I believe in the power of 
strong visual messaging. However, I also believe that multimedia must be grounded in learning theory and sound rationale 
that supports learning objectives. My design approach follows Mayer’s multimedia principles (2005) to help learners engage 
in selecting, organizing, and connecting cognitive processes (p. 2). I use graphics to support text, following the principle of 
multiple representations (Mayer, 2005, p. 2). For example, I will include visual representations of design principles alongside 
written definitions in my activities. I also develop easily identifiable relationships between graphics and text, following the 
contiguity principle (Mayer, 2005, p. 3). Lastly, with the help of my creative writing background, I write instruction not only 
efficiently but also conversationally, following the principles of coherence and personalization (Mayer, 2005, p. 4).

When developing reusable learning objects, I will also apply core assumptions from scenario-based, transformative and 
experiential learning theories to invite direct application and practice. 
	

INSTRUCTIONAL STRATEGIES & LEARNING THEORIES 



8WINONA LEÓN

GOAL ANALYSIS
DESIGN STANDARDS

Using Adobe Creative Suite, learners can create designs that adhere to ten principles of design (Emphasis, Hierarchy, 
Balance, Alignment, Contrast, Proportion, Movement, White Space, and Unity).
1.	 Who? Development staff (learners)
2.	 What? create designs
3.	 Under what conditions? Using Adobe Creative Suite
4.	 Criterion of acceptable performance? adhere to ten principles of design (Emphasis, Hierarchy, Balance, 
Alignment, Contrast, Proportion, Movement, White Space, and Unity)

ACCESSIBILITY

Using Adobe Creative Suite, learners can create designs that adhere to the World Accessibility Initiative’s (WAI)’s 
perceivable Web Content Accessibility Guidelines (WCAG), which make up the international technical standard for 
creating accessible online content, by passing web accessibility checkers, such as Adobe’s Color Contrast tool.
1.	 Who? Development staff (learners)
2.	 What? create designs
3.	 Under what conditions? Using Adobe Creative Suite
4.	 Criterion of acceptable performance? adhere to WAI’s perceivable WCAG by passing web accessibility checkers, 
such as Adobe’s Color Contrast tool

FILE PREPARATION

Using Adobe Creative Suite, learners can create, alter, and save files according to designated web and print specifications.
1.	 Who? Development staff (learners)
2.	 What? create, package, alter and save web and print files
3.	 Under what conditions? Using Adobe Creative Suite
4.	 Criterion of acceptable performance? according to the files’ designated web formats or printer standards

INSTRUCTIONAL GOAL

Using Adobe Creative Suite, learners will be able to create designs that adhere to ten principles of design (Emphasis, 
Hierarchy, Balance, Alignment, Contrast, Proportion, Movement, White Space, and Unity). These designs will also adhere 
to the World Accessibility Initiative’s (WAI) perceivable Web Content Accessibility Guidelines (WCAG), which make up the 
international technical standard for creating accessible online content. Designs will meet these criteria by passing web 
accessibility checkers, such as Adobe’s Color Contrast tool. Learners will also be able to create, alter, and save these files 
according to designated web and print specifications.
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TASK ANALYSIS
METHODOLOGY

Given my instructional goal will involve many technology-related tasks, I’ve completed a procedural analysis below to 
determine how key design concepts are used in the process of creating, designing, and saving design files. Additional topic 
analyses will be created during the RLO development phase to break down the principles of design, file types, and web 
accessibility standards.

TASK ANALYSIS

	 •   Brainstorm and Sketch a Design Concept:
		  o   Make a list of several ideas.
		  o   Draw small sketches of these ideas, making sure to develop focal points and follow the core principles.
	 	 [Core principles definitions: Emphasis, Balance and Alignment, Contrast, Repetition, Proportion,
		  Movement and White Space]
		  o   Narrow choice by seeking outside feedback. 
		  o   Scan a black-and-white 300 dpi file of the sketch and begin digital design.
	 •   Create New Digital File Using an Adobe Creative Suite Program:
		  o   Choose appropriate program based on file format. 
			   lllustrator: good for scalable graphics [vector graphic definition]
			   Photoshop: good for photos or complicated graphics [pixels definition]
			   InDesign: good for print layouts
		  o   Open selected program and create new file in selected program. 
		  o   Pick whether the document is a print or web file format.  
			   In InDesign, your choice will automatically assign file to the typically correct color profile [color
	 	 	 profile definition, including differentiations: CYMK for print and RGB for web], and resolution
			   [resolutions definition, including differentiations: 300 for print and 72 for web]. It will also convert
			   measurements to pixels or inches depending on whether image is being created for web (pixels)
			   or print (inches) format. 
		  o   Create document size in pixels or inches depending on the format.  
		  o   If selected program is InDesign, scroll below image size: Create .25 or .5 in margins depending on
		  graphic size and amount of information needed on graphic. [margins definition] Clicking and unclicking on
		  the paperclip icon to the right will sync the margins to be the same. 
			   For print images: scroll past margins and create a .125in bleed (or use the exact number the
			   designated printer has asked for; .125 in is industry-standard). [bleed definition]
	 •   Insert Scanned Image:
		  o   Place the image in the file with a reduced opacity and lock image layer if desired. 
	 •   Ensure Smart Guides, Rulers, and Grids are Turned On:
		  o   If not, turn them on under View and set desired unit of measurement by CTRL and click.
	 •   Build a Guide Layout Based on Composition of Sketch:
		  o   Use selected program’s Build Guide Layout feature from View in Photoshop, Layout in InDesign, or
		  manually in Instagram by dragging guides.
		  o   Can also use Perspective Grid under View.
		  o   Can also use Master Pages in InDesign to set guides/page templates for longer layouts 
	 •   Develop a Striking and Appropriate Color Palette:
		  o   Use selected program’s color tools and Adobe Color website to build color theme through Color Wheel
		  and then Extract Theme or Gradient. [complementary/adjacent/etc. colors definitions]
		  o   Ensure that the color palette does not disrupt the color scheme of the agency logo by checking style
		  guide and placing the logo on top of these colors. 
	 •   Check Web Accessibility of Color Palette:
		  o   Use Adobe’s Accessibility Tools: Color Contrast Checker and Color Blind Safe. [Web Content
	 	 Accessibility Guidelines (WCAG) core principles and definitions]
	 •   Choose Appropriate Typefaces and Sizes:
		  o   [Typefaces/fonts definitions and core principles]
		  o   Align text using guides if need be.
		  o   Use Character, Paragraph, and Styles menus and functions to size and justify text. 
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TASK ANALYSIS
		  o   [Kerning and related definitions] Ensure sure font size is over 9 pt. Ensure font size correlates with
		  type importance. 
	 •   Develop and Revise Design:
		  o   Troubleshooting solutions:
			   Narrow the focus to one element or design principle.
			   Preview the image.
			   Zoom to the actual image size. Can you still read the text? Can you preview the image online/on 	
			   social media account? Can you print the image?
		  o   Additional questions to ask:
			   Is it easy to read the information? 
			   Does information flow in order of information importance or a logical manner? [UX design core 		
	 	 	 principles]
		  o   Seek and consider outside feedback.
		  o   Revise or go back to the drawing board or previous steps as needed.
		  o   After final approval, polish and finalize design.
	 •   If Necessary, Switch or Alter Color Profile to Meet Desired Format:
		  o   Illustrator: File>Document Color Mode
		  o   InDesign: Edit>Convert to Profile
		  o   Photoshop: Image>Mode
	 •   If Necessary, Switch or Alter Resolutions/Size to Meet Desired Format:
		  o   Illustrator: N/A [vector definition]; can scale image as needed
		  o   InDesign: File>Document Setup 
		  o   Photoshop: Image>Image Size
	 •   Package to Send or Save File + Linked Images and Fonts:
		  o   InDesign: File>Package 
		  o   Photoshop: Convert Layers to Objects and Transfer (Copy) File Contents to Illustrator (Photoshop
		  does not have full packaging function)
		  o   Illustrator: File>Package 
	 •   Save File:
		  o   Depending on whether graphic is for print or web, save according to desired format. Switch size,
		  resolutions, or color profile if necessary.
			   Print: CYMK color; 300-resolution, inches
				    PDFs: margins, bleeds, and printer specifications 
				    TIFFs: transparency and layers
			   Web: RGB color; 72-resolution, pixels
				    JPGs: no transparency, file quality, universal application 
				    PNGs: transparency 
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TERMINAL & ENABLING OBJECTIVES
TERMINAL OBJECTIVE #1

Using Adobe Creative Suite, create designs that adhere to ten principles of design (Emphasis, Hierarchy, Balance, 
Alignment, Contrast, Proportion, Movement, White Space, and Unity). (Cognitive/Psychomotor)
	 Enabling Objectives:  
	 •   Define and differentiate ten principles of design in your own words. (Cognitive: Remembering)
	 •   Given Adobe Creative Suite applications, differentiate programs and their intended uses according to key
	 features and functions. (Cognitive: Remembering)
	 •   Use Adobe Creative Suite application tools and design principles in tandem to develop a digital design. 
	 (Cognitive: Applying/Creating) (Psychomotor: Complex Overt Response and Adaptation)
	 •   Test and troubleshoot design by analyzing a rubric based on design principles and outside feedback. (Cognitive:
	 Analyze) (Psychomotor: Mechanism and Complex Overt Response)
	 •   Revise, improve, and polish design according to troubleshooting results. (Cognitive: Analyze/Creating)
	 (Psychomotor: Mechanism, Complex Overt Response, Adaptative, and Origination)

TERMINAL OBJECTIVE #2

Using Adobe Creative Suite, create designs that adhere to the World Accessibility Initiative’s (WAI)’s perceivable Web 
Content Accessibility Guidelines (WCAG). (Cognitive/Psychomotor)
	 Enabling Objectives:  
	 •   Identify and define the WAI’s perceivable WCAG and corresponding success criteria. (Cognitive: Remembering)
	 •   Use these guidelines to develop WCAG-compliant color palettes, text, and audio options in digital and print 
	 design. (Cognitive: Remembering/Applying/Creating) (Psychomotor: Complex Overt Response and Adaptation)
	 •   Given a web accessibility checker, such as Adobe’s Color Contrast tool, pass at the WCAG level. (Cognitive: 
	 Analyze) (Psychomotor: Mechanism)

TERMINAL OBJECTIVE #3

Using Adobe Creative Suite, create, alter, and save files according to designated web and print specifications. (Cognitive/
Psychomotor) 
	 Enabling Objectives: 
	 •   Differentiate between print and web file specifications, including color modes, image resolutions, units of
	 measurements, and file formats. (Cognitive: Remembering) 
	 •   Create, alter, and save files correctly using these specifications. (Cognitive: Applying) (Psychomotor: Complex
	 Overt Response and Adaptation)
	 •   Test, correct, and/or improve files by previewing designs though web applications and print proofs. (Cognitive:
	 Analyze/Creating) (Psychomotor: Mechanism, Complex Overt Response, Adaptative, and Origination)
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